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Preface

TheC•CURE 9000 Simplex 4100 Fire Alarm Interface User Guide is for new and experienced security system users who want
to learn to use the C•CURE 9000 Simplex 4100 Fire Alarm Interface for the C•CURE 9000 Security Management System.

In this preface

How to Use this Manual 6
FindingMore Information 6
Conventions 7
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How to Use this Manual

This manual contains the following sections that provide information about the C•CURE 9000 Simplex Fire Alarm Interface.

Chapter 1, Introduction

This chapter provides basic information about this integration.

Chapter 2, Installation

This chapter provides installation instructions for the product.

Chapter 3, Simplex 4100 Panel Editor

This chapter describes how to use the Simplex 4100 Panel Editor.

Chapter 4, Simplex 4100 Card Editor

This chapter explains how to use the Simplex 4100 Card Editor.

Chapter 5, Simplex 4100 Point Editor

This chapter describes how to use the Simplex 4100 Point Editor.

Chapter 6, Monitoring Simplex 4100 Activities

This chapter explains how tomonitor Simplex 4100 activities using theMonitoring Station Activity Monitor.

Chapter 7, Simplex 4100 Journal Messages

This chapter describes Simplex 4100 Journal Messages.

Finding More Information

You can access C•CURE 9000manuals and online Help for more information about C•CURE 9000.

Manuals

C•CURE 9000 softwaremanuals are available in Adobe PDF format on the C•CURE 9000 installationmedia.

You can access themanuals if you copy the appropriate PDF files from the C•CURE 9000 Installationmedia
Manuals\CCURE folder.

The available C•CURE 9000 Software Housemanuals are listed in the C•CURE 9000 Installation and UpgradeGuide.

Thesemanuals are also available from the Software HouseMember Center website

http://www.swhouse.com/TechnicalLibrary/TechLibSW.aspx.
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Online Help

You can access C•CURE 9000 Help by pressing F1 or clicking Help from themenu bar in the Administration/Monitoring
Station applications.

Conventions

This guide uses the following text formats and symbols.

Convention Meaning

Bold Bold text describes one of the following items:
• A command or character to type
• A button or option on the screen to press
• A key on your keyboard to press
• A screen element or name

Italic Indicates a new term.

<text> Indicates a variable.

The following items are used to indicate important information.

NOTE Indicates a note. Notes call attention to any item of information that may be of special importance.

TIP Indicates an alternatemethod of performing a task.

Indicates a caution. A caution contains information essential to avoid damage to the system. A caution can
pertain to hardware or software.

Indicates a warning. A warning contains information that advises users that failure to avoid a specific action
could result in physical harm to the user or to the hardware.

Indicates a danger. A danger contains information that users must know to avoid death or serious injury.
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Chapter 1 - Introduction

This chapter introduces the C•CURE 9000 Simplex 4100 integration product.

In this chapter

Simplex 4100Overview 9
Configuring the Connection to a Simplex 4100 Panel 11
Licensing the Simplex 4100 Fire Alarm integration product 21
Using the Hardware Pane 21
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Simplex 4100 Overview

The C•CURE 9000 Simplex 4100 Fire Alarm integration provides advanced, seamless integration with the 4100 Fire Detection
and Alarm Panel from SimplexGrinnell, allowing customers tomonitor their important fire devices from the C•CURE 9000
Monitoring station. This product is intended to provide an upgrade path for systems currently using the SimplexGrinnell iSecure
FireWatch interface (Simplex fire alarm interface).

The SimplexGrinnell 4100 Fire Panel is a high-end, next-generation distributed network system that combines superior fire
protection and informationmanagement with lower costs of installation, maintenance, and ownership.

The union of this high-end fire system and the C•CURE 9000 provides extensive system integration opportunities, including
the ability to receive secondary annunciation from the linked fire alarms. Currently, the 4100 Fire Panel can support up to 2000
signals through a centralized RS-232 connection. This allows security personnel to view all critical events, including access
violations, video alarms, and now fire alarms, from one centralized station. As per fire regulations, no capability is provided for
the security system operators to silence alarms or reset signals to a cleared state on the fire system. As with other important
events in the C•CURE 9000, all fire alarm activity is stored in the system’s detailed journal for future investigative reporting.

The C•CURE 9000 Simplex 4100 integration is based on the Simplex Computer Port Protocol (CPP), a bi-directional serial
protocol capable of accessingmost of the Fire Alarm Control Panel (FACP) operational and diagnostic features.

The integration can be used by C•CURE 9000 to access 4100 panels through CPP. It can acquire point status change, event
status, and health status data from the FACP, then store this information in the C•CURE 9000 database. The integration
supports the secondary annunciation of the devices, panel events, and panel health status data.

The product includes a data acquisition function that does the following:

1. Establishes andmaintains the supervised serial link.

2. Extracts the point database from the FACP.

3. Merges the FACP database into the C•CURE 9000 database.

Once points aremerged into the C•CURE system, they aremanaged and configured like other native system points in
C•CURE 9000.

Features

The C•CURE 9000 Simplex 4100 Fire Alarm integration provides seamless integration with the industry-leading 4100 fire panel
from SimplexGrinnell, including the ability to view all critical security and fire events in one station on one screen.

l Device/point status changes (Fire, Trouble, Disabled, etc.).

l Panel event status (number of Fires, Troubles, etc.).

l Panel health status (AC Power status, battery status, etc.).

l Reporting (logs, service reports, etc.).

l All fire alarm activities are logged in the security journal allowing both life safety and security events to be reviewed
together in future investigative reporting.

Architecture

The objective of the Simplex 4100 Fire Alarm integration is to provide a standard interface between the Simplex 4100 product
family control equipment (4100 and NDU, firmware version 2.03.02 or later) and C•CURE 9000 via an RS-232 serial port or
network port when you used UDS1100 to convert serial port into a network port. This integration provides manual
synchronization between the Simplex 4100 database and the C•CURE 9000 database. The integration listens to Simplex 4100
unsolicitedmessages (fire, Trouble, Supervision, Priority 2) and communicates them to C•CURE 9000. C•CURE 9000

Simplex 4100U Fire Alarm Integration User Guide 9
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processes thesemessages and communicates them to users as object state changes, activities, events, and alarms –
according to the way the Simplex 4100 objects in the C•CURE 9000 database are configured. The Simplex Fire Alarm
integration does not provide control functions for Simplex 4100 products.

The Simplex Fire Alarm integration gives you the ability to create and configure Simplex 4100 Panels in C•CURE 9000, and
synchronize the C•CURE 9000 database and the Simplex 4100 product database. The Simplex Fire Alarm integration also
listens to Simplex 4100 product unsolicitedmessages and processes them into C•CURE 9000 Journal messages.

You can access the Simplex Fire Alarm integration on the C•CURE 9000 Administration Client by clicking theHardware
button. The hardware pane opens and you can access an existing Simplex 4100 panel or create a new one.

Components

The C•CURE 9000 Simplex 4100 integration provides the following new objects for the C•CURE 9000 database:

■ Simplex 4100 panel

The Simplex 4100 Panel object in C•CURE 9000 is the parent object for Simplex 4100 Cards and Simplex 4100 Points.
You can use it to synchronize data between Simplex 4100 Hardware and C•CURE 9000, view a synchronization report,
and configure cards and points that you want to represent in C•CURE 9000.

■ Simplex 4100 Card

The Simplex 4100 card object is the parent object for fire points. Each fire point belongs to one Simplex 4100 Card, and one
Card can have nomore than 250 points. You do not create Simplex 4100 Cards manually; they are created automatically
when you synchronize data from the Simplex 4100 hardware.

■ Simplex 4100 Point

There are two kinds of Simplex fire points. A physical point connects to sensors to detect fire status. A pseudo point
presents Simplex 4100 hardware status. You can create a physical point manually, but you cannot create a pseudo point
manually.

Triggers

The C•CURE 9000 Simplex Fire Alarm integration uses Triggers, which are configured procedures for activating fire alarm
actions. A Trigger automatically executes a specified Action when a particular Condition occurs. The Actions that the
C•CURE 9000 Simplex Fire Alarm integration implements are such fire alarm objects as fire alarm, and panel status change.
When a Trigger is defined, the Action it specifies is the property of the target affected by the trigger itself. The C•CURE 9000
Simplex Fire Alarm integration can use Triggers to configure host events activated by communications failures.

Simplex 4100 Tasks

You can perform the following tasks with C•CURE 9000 Simplex 4100 integration:

l Install the C•CURE 9000 Simplex 4100 integration product (see Installation Overview on Page 24).

l Create a 4100 Panel Object (see Creating a Simplex 4100 Panel on Page 39).

l Configure a 4100 Panel Object (see Configuring a Simplex 4100 Panel on Page 41).

l Import Points using Data Acquisition (see Performing Simplex Panel Data Acquisition on Page 50).

l Configure Cards and Pseudo Points (see Configuring Cards and Points on Page 47).

Simplex 4100 integration Objects

When you create Simplex 4100 Panels, these objects appear in a folder in the C•CURE 9000 Hardware Tree, as shown in
Figure 1-1 on Page 11.



Figure 1-1: Hardware Tree showing Simplex 4100 Panels Objects

Terminology

Table 1 on Page 11 lists some terms and definitions related to the C•CURE 9000 Simplex 4100 integration product.
Table 1: Simplex 4100 Terminology

Term Definition

4120
Network

The UL 864-approved Simplex proprietary fire network – a token-ring network that is based on RS-485
transmission technology and supports copper and/or fiber connectivity.

CPP Computer Port Protocol – a bi-directional serial communications protocol native to the 4100 series fire alarm
panels. It supports unsolicited alarm notification and requests for status updates and provides access to panel
health and diagnostic features.

FACP Fire Alarm Control Panel – similar in content to the iSTAR controller except it can operate as a standalone
panel (no server required).

Points Inputs and outputs that are connected to the 4100 Fire Alarm Control Panel.

Function The purpose of, or the action carried out by, a software or hardware component of a product.

I/O Input output linking – an input event triggers a pre-defined output or chain of events

ISC Integrated Security Controller – the field-located security controller for the iSecure system which supports
functions such as card validation, door lock/unlock, and relay operation

TR Technical Representative – SimplexGrinnell employee stationed in the field to install, program, and/or repair
fire alarm and security systems.

Configuring the Connection to a Simplex 4100 Panel

The C•CURE 9000 Simplex Fire Alarm Interface is an intelligent hardware interface for the Simplex 4100 fire detection system
hardware. The C•CURE Simplex Fire Alarm Interface (with the C•CURE 9000 system server acting as a database and journal
host) and the Simplex 4100 hardware provide fire alarm notification and fire point synchronization. This section explains how to
configure the Simplex Fire Alarm Interface in the C•CURE 9000 system.

Simplex 4100U Fire Alarm Integration User Guide 11
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Simplex 4100 Hardware Preparation

The Simplex 4100 hardware is an intelligent, network-ready fire detection system. The heart of the Simplex 4100 hardware is
the fire point (sensor), that detect the fire status and notify an operator. Simplex 4100 hardware provides an RS-232 serial
communication port to talk with the computer. Before you can connect Simplex 4100 hardware to the C•CURE Simplex Fire
Alarm Interface, the Simplex 4100 hardwaremust have an RS-232 card and youmust configure the Simplex 4100 hardware
using the “4100 Programmer” which ships with the hardware.

Serial Connectivity Settings

The Simplex Fire Panel RS-232 card is connected to the C•CURE 9000 server's COM Port using a null-modem RS-232 cable
with a DB25 connector on the Simplex Fire Panel end and a DB9 connector on the C•CURE 9000 server end.

NOTE Installation and configuration of the RS-232 card for the Simplex 4100 Fire Panel must be performed by the
qualified personnel responsible for the installation and operation of the Simplex 4100 Fire Panel. Typically these
procedures are the responsibility of a Fire Panel Administrator for the site. These personnel can provide to you
the correct setting information so that you can configure C•CURE 9000 to communicate with the 4100 Fire
Panel. Software House is not responsible for configuring the 4100 Fire Panel.

Both the Simplex 4100 hardware RS-232 card and the C•CURE 90000 Simplex Fire Alarm Interface need to be configured for
the same communications settings.  Table 2 on Page 12 shows the options available for the RS-232 card.  The Default RS-232
card settings are the preferred/recommended settings.  Thesemust be set in the 4100 Programmer, and the job when built, and
downloaded into the panel (along with additional settings described in the following sections).

Table 2: Serial Connectivity Settings

C•CURE 9000 Field Simplex Fire Panel

Serial COM Port Simplex RS-232 card, Port B

DB9 connector RS-232 null modem cable, DB25 connector

Serial Port Setting in Panel Editor General
Tab

Baud Rate RS-232 Card Setting Port B TabBaud Rate field.

Parity RS-232 Card Setting Port B TabParity field.

Data Bits RS-232 Card Setting Port B TabData Bits field.

Stop Bits RS-232 Card Setting Port B TabStop Bits field.

Job
Number

4100 Programmer software or Fire Panel Administration
personnel.

RS-232 Card Settings

When you configure the RS-232 Card Settings, you should use Port B, as shown in Figure 1-2 on Page 13, notPort A.  Port A
was designed to support a servicemodem. As a result it broadcasts amodem startup string when the panel is powered up,
which can cause external programs to lock up.  Port B does not have the startup string and thus is immune to this potential
problem. With the communication settings confirmed, click thePort Data button.



Figure 1-2: RS-232 Card Settings

Port Data Entry Settings

The RS-232 card has a number of configuration options for the device type, as shown in Figure 1-3 on Page 14.  In this case,
the RS-232 cardDevice Type field should be configured for COMPUTER.  ThePort default SET priority should be left at the
default of 9.  This restricts access to panel features such as Silence, Acknowledge, and Reset.  These features will only be
available from the Simplex 4100 front panel or on another approved network device like a workstation, NDU, or LCD
Annunciator.  Youmay wish to change the Header and Port ID labels so they will indicate BACnet or FieldServer interface.
Next, click theAccess Level tab.

Simplex 4100U Fire Alarm Integration User Guide 13
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Figure 1-3: Port Data Entry Settings

Access Levels

The Access Levels tab settings, shown in Figure 1-4 on Page 14, should be left at the default levels–no changes should be
made.

Figure 1-4: Access Levels

Port Options

The Port Options tab settings, shown in Figure 1-5 on Page 15, should also remain in the default state. These following three
options provide some important features.



PROTOCOL – indicates that you will be using the Computer Port Protocol structure to send and receivemessages.  This
protocol defines:

l How to structure amessage.

l Which characters to use for the start and finish.

l How tomaintain sequence numbers for message.

l How to calculate and where to locate the checksum in themessage. 

All of these features help to ensure that nomessages are lost/missed and that themessage is correct when it is received.

SUPV – Stands for supervision, which refers to themonitoring of the physical line connecting the two devices.  This must be
used in conjunction with POLL.

POLL – Stands for polling, which refers to themethod of supervision used tomonitor the line.  In process control, this is
sometimes referred to as a heartbeat.  Every 30 seconds, the Fire Panel sends amessage to the external device; the external
device is expected to ACK themessage and then send amessage back to the panel, to which the panel replies with another
ACK.  If any part of the sequence does not occur, the panel starts the poll over.  If any part should fail again, the panel reports
Trouble (indicating Port B Abnormal), and begins trying to re-establish communications with the external device.  Once the
connection has been re-established, the trouble is cleared.

Supervision and Polling ensure that the communication link is in place and that themessages sent to and from the panel are
received intact/not corrupted.

Figure 1-5: Port Options

Network Connectivity Settings

If You want to useNetwork Port to establish communication between C•CURE 9000 server and Simplex 4100 panel, you
must use the third party device Lantronix UDS1100 to convert the serial port into network port. This is a brief instruction on how
to install the UDS1100 hardware device and how to use it to convert a serial port to network port. SeeUDS1100 User Guide ,
provided by Lantronix, for more information.

UDS1100 Hardware Device Installation

To install hardware, complete the following steps:

Simplex 4100U Fire Alarm Integration User Guide 15
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To Install the UDS1100 Hardware

1. Connect the Serial port of Simplex 4100 panel RS-232 card to Serial port of UDS1100 unit by a “straight-through” RS-232
cable. Only the RX, TX andGND connections are used.

2. Connect an Ethernet cable to the RJ45 port of UDS1100 unit.

3. For the UDS1100-POE version, power is supplied to UDS1100 unit over the Ethernet interface using an 802.3af POE-
compliant power source, such as a POE midspan or POE Ethernet switch.

4. For a non-POE UDS1100 unit, supply power to the UDS1100 unit using the power supply that was included in the
packaging.

NOTE The required input voltage for the non-POE DUS1100 is 9-30 VDC (center +) or 10-24 VAC (1.5W
maximum power required).

Figure 1-6: UDS1100-POE Version Connected to Serial Port of Simplex Panel and Network



Figure 1-7: Standard UDS1100 Connected to Serial Port of Simplex Panel and Network

How to Assign IP Address and TCP Port

The following instructions assume you have installed Device Installer Utility. SeeUDS1100 User Guide for more information
about Device Installer Utility.

To Set Serial Port

1. Open yourWeb Browser and type 172.18.11.190 in the Address Bar. (This is the default address.) The USD1100 prompts
for aUser name andPassword.

Figure 1-8: User Name and Password

2. Perform one of the following:

If no Telnet password has been defined (default), leave both fields blank and click OK.

If a Telnet password has been defined, leave the user name blank, type in the password, and then click OK.

TheWeb-Manager displays.

Simplex 4100U Fire Alarm Integration User Guide 17
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Figure 1-9: Lantronix Web-Manage

3. Select Channel 1->Serial Setting from the left mainmenu. The Serial Setting page appears.

Figure 1-10: Serial Settings

4. InSerial Setting page, configure the Port setting according to the serial port setting of Simplex 4100 hardware RS-232
card. They must be configured for the same communications settings. 

To Assign an IP address

1. In theWeb-Manager page, select Network from the left mainmenu. The Network Setting page appears.



Figure 1-11: Network Settings

2. InNetwork Setting page, you can assign an IP Address automatically or manually. The IP Address configured here is
what you should enter in the IP Address field if you select Network Port in Simplex 4100 Panel General tab.

If you want assign an IP Address automatically:

a. Select Obtain IP address automatically.

b. Select the following options (as necessary). Below is a description of these options.

Options Descriptions

BOOTP Select Enable to permit the Bootstrap Protocol (BOOTP) server to assign the IP address from a pool of
addresses automatically. Enable is the default.

DHCP Select Enable to permit the Dynamic Host Configuration Protocol (DHCP) to assign a leased IP address to
the UDS 1100 unit automatically. Enable is the default.

AutoIP Select Enable to permit the UDS1100 to generate an IP in the 169.254.x.x address range with a Class B
subnet. Enable is the default.

DHCP
Host Name

Enter the name of the host on the network providing the IP address.

If you want assign an IP Address manually:

a. Select Use the following IP configuration.

b. Enter the following fields (as necessary). Below is a description of fields.

Fields Descriptions

IP
Address

If DHCP is not used to assign IP addresses, enter the address manually in decimal-dot notation. The IP
address must be set to a unique value in the network.

Simplex 4100U Fire Alarm Integration User Guide 19
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Fields Descriptions

Subnet
Mask

A subnet mask defines the number of bits taken from the IP address that are assigned for the host part.

Default
Gateway

The gateway address, or router, allows communication to other LAN segments. The gateway address should
be the IP address of the router connected to the same LAN segment as the unit. The gateway address must be
within the local network.

DHCP
Server

The DNS server allows the name of a remotemachine to be resolved automatically. Enter the IP address of the
DNS server. If the device is DHCP enabled, the DHCP server provides the DNS server IP address, which

3. Select Auto Negotiate (as necessary). Below is a description of fields.

Fields Descriptions

Auto
Negotiate

With this option, the Ethernet port auto-negotiates the speed and duplex with the hardware endpoint to which
it is connected. This is the default.
If this option is not selected, Speed andDuplex become available:
• Speed: The speed of data transmission. The default setting is 100 Maps.
• Duplex: The direction of data transmission. The default setting is Full.

4. Click OK to finish.

To Assign a TCP Port

1. In theWeb-Manager page, select Connection from the left mainmenu. TheConnection Settings page appears.

Figure 1-12: Connection Setting

2. InConnection Setting page, make the following configuration.

Select TCP in theProtocol drop-down list.

Select Auto Start in theActive Connect drop-down list.



In the Local Port field, type the port number. This number is what you should enter in TCP Port field if you select Network
Port in the Simplex 4100 Panel General tab.

Figure 1-13: Connection Setting Reference

3. Click OK to finish.

Licensing the Simplex 4100 Fire Alarm integration product

The Simplex 4100 Fire Alarm integration is a licensable option for a C•CURE 9000 Server. Youmust purchase a license to use
this software.

When you access the C•CURE 9000 License application on your C•CURE 9000 server, you can see if your license includes
the Simplex 4100 Fire Alarm Interface by running the C•CURE 9000 Licensing program (Start>All Programs>Software
House>C•CURE 9000>Licensing) and clicking theOptions tab. If the Simplex 4100 Fire Alarm Interface is selected ( ),
you have a valid license.

If you do not have a license for the Simplex 4100 Fire Alarm Interface, contact Software House to purchase a license.

You can also view License information from the C•CURE 9000 Administration Client application About Box. Select
Help>About from the Administration Client application, then click the License tab.

Using the Hardware Pane

C•CURE 9000 Simplex 4100 objects are created in the Hardware Pane on your C•CURE 9000 Administration Client
application. Typically you would create a new folder in the Hardware Pane to contain your C•CURE 9000 Simplex
4100 objects.

To Create a New Hardware Folder

To create a new C•CURE 9000 Hardware folder to establish a company or facility and associate it with a Simplex 4100 Panel:

1. Click Hardware to open the Hardware Pane.

2. Right-click the Hardware Folder in the Hardware pane and select Hardware Folder>New.

Simplex 4100U Fire Alarm Integration User Guide 21
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The Hardware Folder dialog box opens for you to type a name in theName field and a textual description in the
Description field.

3. Click Save and Close to save your Hardware Folder.

4. After you create the new folder.

You can right-click it to create a new Simplex 4100 Panel.

The Simplex 4100 Panel object represents the Simplex 4100 Fire Panel in the C•CURE 9000 database. The Simplex 4100
Panel is the parent object for Simplex 4100 Cards and Simplex 4100 Points. After you have created a Panel object, you can
perform Data Acquisition to populate the panel with the Simplex 4100 Cards and Points that are attached to the Panel.
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Chapter 2 - Installation

This chapter provides instructions for installing the C•CURE 9000 Simplex 4100 Fire Alarm Interface product.

In this chapter

Installation Overview 24
Getting the Simplex 4100 integration software 25
Installing the Simplex Fire Alarm integration 25
Uninstalling the Simplex Fire Alarm integration 33
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Installation Overview

Before installing the Simplex 4100 Fire Alarm integration, youmust first install C•CURE 9000 software on your target
computers. For information on installing C•CURE 9000, refer to theC•CURE 9000 Installation and UpgradeGuide.

Similar to the C•CURE 9000 system, the Simplex Fire Alarm integration has Client and Server components. Youmust install
these Client components on every computer that runs C•CURE 9000 client applications, and youmust install the Server
components on the C•CURE 9000 server computer. The Simplex Fire Alarm integration has the same hardware, software, and
disk space requirements as C•CURE 9000; if the target computer can install C•CURE 9000, then it satisfies Simplex Fire
Alarm integration requirements.

To install the Simplex Fire Alarm integration, you run the Simplex 4100 integration setup.exe from the Simplex 4100 integration
installation kit.

A wizard prompts you to install the Simplex Fire Alarm integration. You need to perform the basic installation process
described in the following pages on each computer in your C•CURE 9000 fire detection system. Be sure to close all C•CURE
9000 and virus-checking applications on client workstations.

Table 3 on Page 24 lists the steps to install and register the Simplex Fire Alarm integration on each computer in your fire
detection system. Perform these steps in order.

Table 3: Standard Installation Tasks

Task See…

1. Install C•CURE 9000. C•CURE 9000 Installation and UpgradeGuide

2. Close any open applications and disable virus checking software.

3. Perform the pre-installation steps. See Before You Begin on Page 24

4. Start the Simplex Fire Alarm integration installation program. See Installing the Simplex Fire Alarm integration
on Page 25.

5. If you install Server Software, register the software.

6. When the Installation and registration are complete, shut down and
restart the computer.

Before You Begin

Youmay need to perform some pre-installation steps before you install the Simplex Fire Alarm integration.

Checking Network Status

If you are installing C•CURE 9000 on a corporate network, be sure to coordinate with your corporate network administrator.
Check that the network is working properly.

Checking System Privileges

To perform the installation, youmust have appropriateWindows permissions. Youmust be in the local Administrators group, or
have equivalent privileges. See theMicrosoft Operating System documentation or your system administrator for more
information.

If you do not have sufficient permissions, the error message shown in Figure 2-14 on Page 25displays:
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Figure 2-14: Privileges Error Message

Database Installation

If you are installing server components of the Simplex Fire Alarm integration, the Simplex Fire Alarm integration will add some
tables to the C•CURE 9000 database. Currently, the Simplex Fire Alarm integration does not support installation with
C•CURE 9000 on anOracle Database. Therefore youmust install on a C•CURE 9000 system that is using SQL Server. The
Simplex Fire Alarm integration install program automatically finds the C•CURE 9000 database and adds tables and initial data
to it.

Getting the Simplex 4100 integration software

You can download the Simplex 4100 integration software from the Software House website.

Downloading the Simplex 4100 integration software from the Software House website

1. Open a browser and navigate towww.swhouse.com.

2. Select Products, and then select Software Downloads in the list.

3. When the login page opens, log in. If you do not have an account, youmust create one.

4. Click theSoftware Downloads link.

5. On theSoftware Downloads page, select the "Software House Connected" link.

6. Select Fire Alarm from list.

7. When the Fire Alarm Driver Downloads list is displayed on the right hand of the page, select the SimplexGrinnel driver link
for the version of C•CURE 9000 that you have installed.

8. Unzip the files to a folder on your local computer, or to a shared drive on the network.

Installing the Simplex Fire Alarm integration

This section provides the Simplex installation procedure. You can install the software to a drive from a local computer or from a
shared drive over the network.

This section assumes that youmeet all the requirements described in Pre-installation Requirements.

NOTE For information about sharing folders, refer to your Microsoft documentation or see your system administrator.

Running the Setup Program

To install the Simplex 4100 Fire Alarm integration, complete the following task:



To Run the Setup Program

1. Log into the Server or Client withWindows administration privileges.

2. Navigate to the Simplex 4100 integration installer.

3. Right-click setup.exe, and select Run as administrator, the following confirmation dialog box appears.

Figure 2-15: Confirmation Dialog Box

4. Click Install, Click Install, the Fire Framework Welcome dialog box appears. The fire framework is an inside component
required by Simplex 4100 integration.

Figure 2-16: Fire Framework WelcomeDialog Box

5. Click Next to continue the installation. A License Agreement dialog box opens.
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Figure 2-17: Fire Framework EULA

6. Select I accept the terms in the license agreement and click Next, a Database Server dialog box appears.

Figure 2-18: Database Server Dialog Box

7. Click Next, the Redundant Server Setup dialog box appears.



Figure 2-19: Redundant Server Setup

8. Click Next to open the Ready to Install the Program dialog box.

Figure 2-20: Ready to Install
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9. Click the Install, the installing progress dialog box appears.

Figure 2-21: Installing Fire Framework

10. After finishing, the installation complete dialog box appears.

Figure 2-22: Fire Framework Completed

11. Click Finish, then start to install Simplex 4100 integration. The program checks the system to see if it meets minimum
requirements. If minimum requirements aremet, aWelcome dialog box opens.



Figure 2-23: WelcomeDialog Box

12. Click Next to continue the installation. A License Agreement dialog box opens.

Figure 2-24: Database Dialog Box

13. Click Next, the Redundant Server Setup dialog box appears. The Simplex Fire Alarm integration installation package will
search for the C•CURE 9000 redundant server setting and display it in the dialog box (this field is read-only). Click Next to
start the installation.
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Figure 2-25: Redundant Server Setting Dialog Box

14. Click Next to continue the installation. The Ready to Install the Program dialog box appears. Click Install to start the
installation.

Figure 2-26: Ready to Install the Program Dialog Box

15. The Installing Progress dialog box appears.



Figure 2-27: Installation Progress Dialog Box

16. The Installing Progress dialog box appears.

Figure 2-28: Installation Progress Dialog Box

After a few minutes, the Installation Complete dialog box appears.
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Figure 2-29: Installation Complete Dialog Box

17. Click Finish to complete the installation process.

NOTE Before you can configure a Simplex 4100 Panel, youmust start the Simplex 4100 Hardware integration using
theServer Configuration ApplicationServices tab.

1. From the Start Menu, select Start>All Programs>Software House>Server Configuration.

2. Click theServices tab.

3. Select theEnabled check box for theSoftwareHouse CrossFire Simplex4100 Driver Service and
then start the service.

Uninstalling the Simplex Fire Alarm integration

This section describes how to uninstall the Simplex Fire Alarm integration software from the Server computer and from each
Client computer in your security system.

The Uninstall process removes all software components that were installed on the computer by the Simplex Fire Alarm
integration installation program.

Please be advised that the Simplex integration uninstall will shut down and restart the C•CURE 9000
services. Therefore, the Simplex integration uninstall should be planned accordingly.

Uninstalling this integration does not automatically remove objects that were configured in the C•CURE
9000 using it. Before you proceed with this uninstall, youMUSTmanually remove the objects from
C•CURE 9000 to avoid potential issues with functions, such as partition deletion. Unless you intend to
reinstall the integration and continue using it, please ensure that the objects are deleted before removing
the integration.

Once the uninstall process completes, the computer will be in a "clean" state.



To Uninstall the Simplex Fire Alarm integration

1. On theWindows Start menu, select Settings>Control Panel.

2. Double-click Add/Remove Programs. The Add/Remove Programs dialog box appears (see Figure 2-30 on Page 34.)

Figure 2-30: Add/Remove Programs

3. Select Simplex4100 from the list.

4. Click Change/Remove. The C•CURE 9000 Simplex 4100 Service Setup dialog box appears (see Figure 2-31 on Page
34.)

Figure 2-31: C•CURE 9000 Simplex 4100 Service Setup Dialog Box

5. Click Next and the Simplex ProgramMaintenance dialog box appears.(see Figure 2-32 on Page 35).
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Figure 2-32: ProgramMaintenance Dialog Box

6. Select Remove to remove the Simplex 4100 integration. Click Next on the Simplex ProgramMaintenance dialog box.

The Uninstall Options dialog box appears.

Figure 2-33: Uninstall Options Dialog Box

7. (Optional) To uninstall the database, select theDrop the Simplex4100 database tables check box.

8. Click theRemove button.

The Uninstalling C•CURE 9000 Simplex 4100 Service dialog box appears.



Figure 2-34: Uninstalling C•CURE 9000 Simplex 4100 Service Dialog Box

The C•CURE 9000 Simplex 4100 Service Setup Complete Dialog Box appears. Click Finish to finish uninstallation.

Figure 2-35: C•CURE 9000 Simplex 4100 Service Setup Complete Dialog Box
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Chapter 3 - Simplex 4100 Panel Editor
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Simplex 4100 Panel Editor Overview

You can configure a Simplex 4100 Panel object using the Simplex 4100 Panel Editor.

Simplex 4100 Panel Editor Tabs

The Simplex 4100 Panel Editor has the following tabs:

l Simplex 4100 Panel General Tab on Page 40

l Simplex 4100 Panel Basic Information Tab on Page 42

l Simplex 4100 Panel Triggers Tab on Page 42

l Simplex 4100 Panel Status Tab on Page 45

l Simplex 4100 Panel State Images Tab on Page 46

Simplex 4100 Panel Editor Tasks

You can perform the following tasks when configuring a Simplex 4100 Panel object:

l Accessing the Simplex 4100 Panel Editor on Page 38

l Creating a Simplex 4100 Panel on Page 39

l Configuring a Simplex 4100 Panel on Page 41

l Performing Simplex Panel Data Acquisition on Page 50

l Configuring Cards and Points on Page 47

l Viewing Import Reports on Page 53

l Customizing State Images for a Simplex 4100 Panel on Page 47

l Finding a Simplex Panel in the Audit Log on Page 58

l Finding a Simplex Panel in the Journal on Page 57

Accessing the Simplex 4100 Panel Editor

You can access the Simplex 4100 Panel Editor to create a Simplex 4100 Panel, or configure an existing one.

To Access the Simplex 4100 Panel Editor

1. In the Navigation pane of the C•CURE 9000 Administration workstation, click Hardware. The Hardware pane opens.

2. Open the Hardware Folder containing your Simplex 4100 Panel by clicking to the left of the folder.

3. Open the Simplex 4100 folder by clicking to the left of folder.
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4. To open the Simplex 4100 Panel Editor to edit an existing Simplex Panel, double-click a Simplex 4100 Panel icon or
name.

To create a new Simplex 4100 Panel and edit it with the Simplex 4100 Panel Editor, right-click the folder and select
Simplex Panel>New from the context menu.

The Simplex 4100 Panel Editor opens with the General tab visible.

Creating a Simplex 4100 Panel

C•CURE 9000 Simplex 4100 integration supports multiple Simplex 4100 panels.

Perform the following steps to create a new Simplex 4100 Panel.

To Create a Simplex 4100 Panel

1. In the Navigation Pane of the AdministrationWorkstation, click Hardware to open the Hardware pane.

2. Right-click the company name folder in the Hardware pane tree. (Alternatively, you can create a new hardware folder to
contain your Simplex 4100 panel by right-clicking Hardware and choosingNew Folder.)

3. Select Simplex 4100 Panel and click New.

4. The Simplex 4100 Panel Editor opens, allowing you to configure the Panel. See Configuring a Simplex 4100 Panel on Page
41 for more information.

5. To save the new Simplex 4100 panel, click .

Alternatively, if you want to save the Panel and create a new one, click . The Simplex 4100 Panel Editor
remains open to allow you to create a new Panel.

Deleting a Simplex 4100 Panel

You can delete a Simplex 4100 Panel if you no longer need it.

To Delete a Simplex 4100 Panel

1. In the Navigation Pane of the AdministrationWorkstation, click Hardware to open the Hardware pane.

2. Select Simplex 4100 Panel from the Hardware pane drop-down list.

3. Click to open a Dynamic View showing all Simplex 4100 Panel objects.

4. Right-click the Simplex 4100 panel in the list that you want to delete and select Delete from the context menu.

A message box appears stating “All children cards and points of the panel will be deleted. Do you want to continue?”

5. Click Yes in themessage box to delete the panel.

NOTE Only a disabled Simplex 4100 Panel can be deleted. To disable a Simplex 4100 Panel, edit the Simplex 4100
Panel and change theEnabled option from to (see Configuring a Simplex 4100 Panel on Page 41).



Simplex 4100 Panel General Tab

The Simplex 4100 Panel General tab, shown in Figure 3-36 on Page 40, lets you set the Simplex 4100 panel Job Number,
Synchronization Setting and Communication Information. (The Job Number is a unique number that identifies specific Simplex
4100 Panel hardware.) Youmust know the job number for your panel before you can configure the Simplex 4100 Panel in the
C•CURE 9000 System.

Figure 3-36: Simplex 4100 Panel General Tab

Simplex 4100 Panel General Tab Definitions

Table 4 on Page 40 provides definitions for the fields and buttons on the Simplex 4100 Panel General Tab.
Table 4: Simplex 4100 Panel General Tab Definitions

Field Definition

Name Enter a unique name up to 50 characters long for the Simplex 4100 panel. If you enter the name of an
existing object, the system will not save the object, and will display an error message indicating there is
a conflict. Choose a different name.

Description Enter a general comment about the Simplex 4100 panel that will help you identify the Panel. This text is
for information only.

Enabled Select theEnabled option to put the Simplex 4100 panel online.
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Field Definition

Job Number Job Number is a unique eight-character string that can include alphabetic characters and numbers. It
identifies specific Simplex 4100 hardware. The job number is built into the Simplex 4100 hardware and
cannot be changed. Youmust obtain the job number before you can configure the Simplex 4100 panel in
the C•CURE System. You find the job number in the “4100 Programmer” which ships with the Simplex
4100 hardware.
Youmust enter a job number when you create a Simplex 4100 panel, and you can't create a Simplex
4100 panel with a duplicate job number. The job number cannot bemodified after the Simplex 4100
panel has been created.

Configure
Cards and
Points

Click this button to configure cards and points used when Data Acquisition.

Communication
Information

You can set communication information in this box.
Network Port -When you use UDS1100 to convert the serial port of RS-232 card into a network port,
select theNetwork Port. Type the IP address and TCP Port of this network port, with which C•CURE
9000 server can remotemanage Simplex Fire panel. WhenNetwork Port is selected, Serial Port
setting is grayed out.
Serial Port -When you connect the serial port of RS-232 card directly to C•CURE 9000 server's COM
Port, select theSerial Port. In the COM Port drop-down list, select the COM Port connected to the
serial port of RS-232 card, with which C•CURE 9000 server' communicates with Simplex Fire panel.
WhenSerial Port is selected, Network Port setting is grayed out.

Configuring a Simplex 4100 Panel

You can use the Simplex 4100 Panel Editor to configure settings for the Simplex 4100 Panel.

To Configure a Simplex 4100 Panel

1. In the Navigation Pane of the AdministrationWorkstation, click Hardware to open the Hardware pane.

2. Select Simplex 4100 Panel from the Hardware pane drop-down list.

3. Click to open a Dynamic View showing Simplex 4100 Panel objects.

4. Double-click the Simplex 4100 panel in the list that you want to modify. The Simplex 4100 Panel Editor opens.

5. Type a unique name in theName field.

6. Type a textual description for the Simplex 4100 in theDescription field.

7. Click theEnabled option to put the Simplex 4100 panel online.

8. Provide the Job Number for this Panel. See Simplex 4100 Panel General Tab Definitions on Page 40 for more detail on the
Job Number.

9. SelectManually for theSynchronization Setting. See the Simplex 4100 Panel General Tab Definitions on Page 40 for
more detail on selecting a Synchronization Setting.

NOTE After you set the synchronization setting, use the Data Acquisitionmenu to initialize the Simplex 4100
panel.

10. See Simplex 4100 Panel General Tab Definitions on Page 40 to configure communication information.

11. You can click the Triggers tab to configure Triggers for the Simplex 4100 Panel. See Defining Triggers for a Simplex 4100
Panel on Page 44.



12. You can click the State Images tab to view the state images for the Simplex 4100 Panel, and optionally customize the
state images. See Customizing State Images for a Simplex 4100 Panel on Page 47.

13. If you are done editing the Simplex 4100 Panel, click to save the Panel's configuration.

Alternatively, if you want to save the Panel and create a new one, click . The Simplex 4100 Panel Editor
remains open to allow you to create a new Panel.

Simplex 4100 Panel Basic Information Tab

The Simplex 4100 Panel Basic Information tab displays information about the Simplex 4100 hardware. When you create a new
Simplex 4100 panel, this tab is empty. The Basic Information tab is filled in automatically when you establish communications
with the Simplex 4100 Panel.

Simplex 4100 Panel Basic Information Tab Definitions

The Simplex 4100 Panel Basic Information tab has the fields described in Table 5 on Page 42. All fields are read-only.
Table 5: Simplex 4100 Panel Basic Information Tab Definitions

Field Definition

Panel Serial
Number

The Panel serial number identifies the Simplex 4100 Panel hardware

Job Revision The current job in the Simplex 4100 Panel hardware. When the Simplex 4100 Panel hardware is upgraded,
the job revision increases.

System
Revision

The Simplex 4100 Panel hardware system revision. Currently, the Simplex Fire Alarm Interface only
supports System Revision 2.02 or later.

Build Time The date and time when the current job revision was created in the Simplex 4100 Panel hardware.

CFIG Format The current database format of the configuration file that is downloaded to the 4100 panel.  The CFIG file
contains all of the data for the specific fire system.

Simplex 4100 Panel Triggers Tab

C•CURE 9000 uses Triggers, which are configured procedures for activating events based on properties of an object. A Trigger
automatically executes a specified Action when a particular predefined condition occurs. Figure 3-37 on Page 43 shows the
Simplex 4100 Panel Triggers tab.
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Figure 3-37: Simplex 4100 Panel Triggers Tab

Table 6 on Page 43 contains an example of how a Trigger is configured. 
Table 6: Triggers Tab Settings Example

The following Triggers tab settings:

Property Value Action Details Schedule

CommunicationStatus CommFail Activate Event Simplex Panel
Event

Always

Would create the following Trigger:
Any time (Always Schedule) the CommunicationStatus (Property) equals CommFail (Value), activate the
event (Action) named Simplex Panel Event (Details).
Simplex Panel Event is an Event that you would need to create using the Event Editor.

Simplex 4100 Panel Triggers Tab Definitions

Table 7 on Page 43 provides definitions for the fields and buttons that appear on the Simplex 4100 Panel Triggers tab.
Table 7: Simplex 4100 Panel Triggers Tab Definitions



Field Description

Add Click in the Triggers tab to create a new trigger.

Remove Click the row and click in the Triggers tab to delete a trigger

Property Click within the Property column, and then click . The Property browser opens presenting properties
available for the Panel. Click a Property to select it and add it to the column.

Value Click within the Value column to display a drop-down list of Values associated with the Property that you have
selected. Click a Value that you want to include as a parameter for the trigger to add it to the column.

Action Click within the Action column to display a drop-down list of valid actions. Click on Action that you want to
include as a parameter for the trigger to add it to the column.
As you select an Action, a corresponding entry field, or group of entry fields, appear at the bottom of the dialog

box. Click to select entries for these fields.

Details Displays details about how the Action was configured.

Schedule Click within the Schedule column to select a Schedule. Click to select a Schedule that you want to
associate with the trigger. Schedules are created in the Configuration Pane.

Simplex 4100 Panel Triggers Tab Tasks

SeeDefining Triggers for a Simplex 4100 Panel on Page 44 for steps to define Triggers for your Simplex 4100 Panel.

Defining Triggers for a Simplex 4100 Panel

Perform the following steps to create a Trigger for a Simplex 4100 Panel.

To Create a Trigger for a Simplex 4100 Panel

1. From the Simplex Panel dialog box, navigate to the Triggers tab.

2. Click in the Triggers tab to create a new Trigger.

3. Click within theProperty column to open the Simplex Panel dialog box showing the Properties available for the
Panel.

4. Click a Property to select it and add it to theProperty column.

5. Click within theValue column to display a drop-down list of Values associated with the Property that you have selected.
Click a Value that you want to include as a parameter for the trigger to add it to the column. (If there is no set list of Values,
you can type in a Value.)

6. Click within theAction column to display a drop-down list of valid actions. Click an Action that you want to include as a
parameter for the trigger to add it to the column.

When you select an Action, the lower pane in the Triggers box displays an entry field or group of entry fields, specific to the
selected Action, so that you can configure the Details for the Action.

Once you define the Action details, the Details column displays information about how the Action has been configured.

For example, if an Event field is displayed in Details, you can click to select an Event that you want to associate with
the Trigger.
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7. Click to save the Simplex 4100 Panel with the Trigger you configured.

To Remove a Trigger

1. From the Simplex Panel dialog box, navigate to the Triggers tab.

2. Use to select the row in the Triggers table for the Trigger you want to remove.

3. Click .

4. Click to save the Simplex Panel.

Simplex 4100 Panel Status Tab

The Simplex 4100 Panel Status tab (see Figure 3-38 on Page 45) provides read-only status information about the Simplex 4100
Panel object.

Figure 3-38: Simplex 4100 Panel Status Tab

Simplex 4100 Panel Status Tab Definitions

Table 8 on Page 46 provides definitions for the values of the Communications Status field.



Table 8: Simplex 4100 Panel Status Tab Definitions

Field Value Definition

Communication
Status

Unknown The Simplex 4100 Panel status is unknown. The Simplex 4100 hardware interface has not
started.

Disabled The Simplex 4100 panel is disabled.

Invalid The wrong Simplex 4100 hardware is connected to the Simplex Fire Alarm Interface. The
job number is not equal or the job revision is less than the current Simplex 4100 Panel.

Online The Simplex 4100 panel is connected to the Simplex Fire Alarm Interface.

Offline The Simplex 4100 Panel is not connected to the Simplex Fire Alarm Interface.

Simplex 4100 Panel State Images Tab

The Simplex 4100 Panel State Images tab, shown in Figure 3-39 on Page 46, provides ameans to change the default images
used to indicate the Simplex 4100 panel states on theMonitoring Station.

Figure 3-39: Simplex 4100 Panel State Images Tab

You can replace the default images with JPG formatted files of your choice, to uniquely identify your objects when activities
are displayed on theMonitoring Station Client. Simplex 4100 Fire Alarm Interface provides the pre-defined custom icons for
simplex point under \Tyco\CCURE Client\SimplexIcon folder.

Simplex 4100 Panel State Images Tasks

SeeCustomizing State Images for a Simplex 4100 Panel on Page 47.
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Customizing State Images for a Simplex 4100 Panel

From the Simplex 4100 Panel State Images tab, you can change the images that appear in theMonitoring Station to represent
Simplex 4100 Panels.

To Customize Simplex 4100 Panel State Images

1. From the Simplex Panel State Images tab, double-click the existing image. A Windows Open dialog box appears allowing
you to browse for a folder in which you have placed replacement images.

2. When you locate the replacement image, select it and click Open to replace the default image with this image.

3. When you are done editing the Simplex 4100 Panel, click to save the Panel's configuration.

Alternatively, if you want to save the Panel and create a new one, click . The Simplex 4100 Panel Editor
remains open to allow you to create a new Panel.

To Restore the Default State Image

1. From the Simplex Panel State Images tab, select an existing image.

2. Right-click the image and select Restore Default.

3. Click to save the Panel Port configuration.

Configuring Cards and Points

A Simplex 4100 Fire Detection and Alarm Panel system has a large number of physical/pseudo cards and points. Youmay not
be interested in many of these. You can configure the interface to C•CURE 9000 to include only those cards and pseudo points
that you are interested in managing andmonitoring through C•CURE 9000.

To configure cards and points for a Simplex 4100 Panel, right-click your panel and select Edit to openSimplex 4100 Panel
Editor. InGeneral tab, select Config Physical Cards and Pseudo Points button (see Figure 3-40 on Page 48). A Config
Physical Cards and Pseudo Points dialog box opens.



Figure 3-40: Config Physical Cards and Pseudo Points Menu Selection

The Config Physical Cards and Pseudo Points dialog box lets you set the relevant cards and points by performing the following
tasks:

l Configuring Cards for a Simplex 4100 Panel on Page 48

l Configuring Pseudo Points for a Simplex 4100 Panel on Page 49

NOTE You can only configure physical cards and pseudo points.

l Physical cards have a card number from 0 to 127.

l Pseudo points have a card number from 128 to 255.

The configuration information will apply to all panels you have configured.

Configuring Cards for a Simplex 4100 Panel

You can configure Physical Cards for your Simplex 4100 Panel by using the following steps.

To Configure Cards for a Simplex 4100 Panel

1. From the C•CURE 9000 Administration application, choose theHardware pane.

2. Right-click one Simplex 4100 Panel instance, select Edit to openSimplex 4100 Panel Editor.

3. InGeneral tab, select Configure Physical Cards and Pseudo Points button. The Config Physical Cards and Pseudo
Points dialog box appears (see Figure 3-41 on Page 49), with the Physical Cards tab displayed. The cards in blue in the
Physical Cards tab are the actual cards in Simplex 4100 Panel.
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Figure 3-41: Configure Physical Cards and Pseudo Points Dialog Box

4. You can add a physical card if the card you are interested in does not exist in theAll Cards list:

a. Type a card name in theCard Name field.

b. Click to add a new card.

5. You canmove cards you are interested in from theAll Cards list to the Interested Cards list by selecting the Cards and
clicking .

Conversely, you canmove cards you are not interested in configuring from the Interested Cards list to theAll Cards list
by selecting the Cards and clicking .

6. Once you havemoved all the Cards you want to configure to the Interested Cards list, click to save your
settings or click thePseudo Points tab to configure pseudo points.

7. You also can click to cancel your settings. A confirmationmessage box appears.

8. Click OK to close the dialog box orCancel to keep the dialog box open.

Configuring Pseudo Points for a Simplex 4100 Panel

You can configure Pseudo Points for a Simplex 4100 Panel by using the following steps.

To Configure Pseudo Points for a Simplex 4100 Panel

1. Click the Pseudo Points tab (see Figure 3-42 on Page 50).



Figure 3-42: Pseudo Points Tab

2. To add a new Pseudo Point that is not in either list:

a. Type a Point ID in thePID field.

b. Click to add the pseudo point to the list.

3. You canmove points you are interested in from theAll Points list to the Interested Pseudo Points list by clicking
.

Conversely, you canmove points you do not want from theAll Interested Pseudo Points list to theAll Points list by
clicking .

4. Once you havemoved all the Points you want to configure to the Interested Pseudo Points list, you can click
to save your settings .

5. You also can click to cancel your settings. A confirmationmessage box appears.

6. Click OK to close the dialog box orCancel to keep the dialog box open.

Performing Simplex Panel Data Acquisition

Once you have created a new panel and finish the card/pseudo point configuration, you can synchronize the C•CURE 9000
database with the physical Simplex 4100 product.

You synchronize Simplex 4100 product data with C•CURE 9000 using Data Acquisition.

To Perform Simplex Panel Data Acquisition

1. Navigate to your Simplex 4100 Panel in the Hardware Tree, select the Panel, and then right-click.

2. Click Data Acquisition in the context menu (see Figure 3-43 on Page 51).
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Figure 3-43: Simplex Panel Context Menu

A Welcome dialog box appears (see Figure 3-44 on Page 51).

Figure 3-44: Data AcquisitionWelcomeDialog Box

If the physical Simplex 4100 product has connected with the C•CURE 9000 Server and the configuration is
correct, the Simplex Fire Alarm Interface retrieves the basic information from your physical Simplex 4100
products and displays it in the Panel Basic Information dialog box (see Figure 3-45 on Page 51).

Figure 3-45: Panel Basic Information



3. Click Next, a Config Physical Cards and Pseudo Points dialog box opens. See Configuring Cards and Points on Page 47
to configure cards and Points.

4. When cards and points configuration completed, click Next, the Data Transfer Progress dialog box displays showing
progress (see Figure 3-46 on Page 52).

Figure 3-46: Data Transfer Progress

The system then displays a data import report (see Figure 3-47 on Page 52).

Figure 3-47: Data Import Report

5. To save this data into the C•CURE 9000 database, click Save to Database. A message box appears indicating that the
points are being saved (see Figure 3-48 on Page 52).

Figure 3-48: Saving Points to the Database

Once the data has been saved to the C•CURE 9000 database, a Point Status message box displays, showing a count of
the number of updated points (see Figure 3-49 on Page 53).
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Figure 3-49: Point Status Message Box

The Data Acquisition dialog boxes then closes, and the Data Acquisition process is complete.

Viewing Import Reports

You can check the Data Acquisition (Import) reports from the Simplex 4100 Panel context menu.

To View Import Reports from a Simplex 4100 Panel

1. From the C•CURE 9000 Administration application, choose theHardware pane.

2. Right-click the Simplex 4100 panel for which you want to View Imports.

3. Select View Import Reports from the context menu (see Figure 3-50 on Page 53). The Import Report List appears in the
Content Area, as shown in Figure 3-51 on Page 54.

Figure 3-50: View Import Reports



Figure 3-51: Import Report List

4. Double-click a report in the list to display the report detail dialog box (see Figure 3-52 on Page 54).

Figure 3-52: Report Detail
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5. Click theNew Point List tab to display all new imported points (as shown in Figure 3-53 on Page 56).



Figure 3-53: New Point List Tab

6. Click theChanged Point List tab to display all changed points (See Figure 3-54 on Page 56).

Figure 3-54: Changed Point List Tab

7. Click theDeleted Point List tab, to view all deleted points (see Figure 3-55 on Page 56).

Figure 3-55: Deleted Point List Tab

8. Click the Failed Import List tab to view all points that failed to import (see Figure 3-56 on Page 56).

Figure 3-56: Failed Import List Tab
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Viewing a List of Simplex 4100 Panels

You can display a Dynamic View that lists Simplex 4100 Panels.

To View a List of Simplex 4100 Panels

1. In the Navigation Pane of the AdministrationWorkstation, click Hardware to open the Hardware pane.

2. Select Simplex 4100 Panel from the Hardware pane drop-down list.

3. Click to open a Dynamic View showing all Simplex 4100 Panel objects.

Simplex Panel Context Menu 

When you right-click a Simplex Panel in the Hardware Tree or in a Dynamic View, a context menu appears. You can select an
action to perform from themenu. The actions shown in Table 9 on Page 57 are available.

Table 9: Simplex Panel Context Menu

Selection Description

Edit Click this menu selection to open the Simplex Panel Editor to edit the Comm Port object.

Delete Click this menu selection to delete the Simplex Comm Port object.

Data
Acquisition

Click this menu selection to perform Data Acquisition. See Performing Simplex Panel Data Acquisition on
Page 50.

View
Import
Reports

Click this menu selection to View Import Reports. See Viewing Import Reports on Page 53

Find in
Audit Log

Click this menu selection to search the Audit Log for system activities involving this Simplex Panel. For
example, you can find the Audit Logmessage that was written when this Simplex Panel object was created
or modified. See Finding a Simplex Panel in the Audit Log on Page 58.

Find in
journal

Click this menu selection to search the Journal for system activities involving this Simplex Panel. For
example, you can find the Journal message that was written if a Trigger was activated for this Panel. See
Finding a Simplex Panel in the Journal on Page 57.

Finding a Simplex Panel in the Journal

You can search for the Journal Entries related to a Simplex Panel by clicking Find in Journal from the context menu of a
Simplex Panel in either the Hardware Tree or a Dynamic view.



To Find Journal Entries for a Simplex Panel

1. Right-click a Simplex Panel object in the Hardware Tree or in a Dynamic View (see Viewing a List of Simplex 4100 Panels
on Page 57).

2. Click Find in Journal on the context menu.

3. A Query Parameters dialog box appears.

l By default, this query searches in the Journal for occurrences of the selected Simplex Panel within the last 7
days. You can accept the default values and click Run to run the query.

l Alternatively, you can click Modify to modify the Query definition, adding or removing Query parameters.

4. Click Run. A Dynamic View opens displaying the Journal Entries for the Simplex Panel you selected.

Finding a Simplex Panel in the Audit Log

You can search for the Audit Log Entries related to a Simplex Panel by clicking Find in Audit Log from the context menu of a
Simplex Panel in either the Hardware Tree or a Dynamic view.

To Find Audit Log Entries for a Simplex Panel

1. Right-click a Simplex Panel object in the Hardware Tree or in a Dynamic View (see Viewing a List of Simplex 4100 Panels
on Page 57).

2. Click Find in Audit Log on the context menu.

3. A Query Parameters dialog box appears.

l By default, this query searches in the Audit Log for occurrences of the selected Simplex Panel within the last
7 days. You can accept the default values and click Run to run the query.

l Alternatively, you can click Modify to modify the Query definition, adding or removing Query parameters.

4. Click Run. A Dynamic View opens to display the Audit Log Entries for the Simplex Panel you selected.
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Chapter 4 - Simplex 4100 Card Editor

This chapter explains how to create and configure Simplex 4100 Cards.

In this chapter

Simplex 4100 Card Editor Overview 60
Simplex 4100 Card Editor General Tab 61
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Simplex 4100 Card Editor Overview

The Simplex 4100 Card object represents the Simplex 4100 Cards in the C•CURE 9000 database.

The Simplex 4100 Card Editor has one tab:

Simplex 4100 Card Editor General Tab on Page 61

You can perform the following tasks with Simplex 4100 Cards:

l You can double-click any card in the Hardware Tree to open the Simplex 4100 Card Editor to see the card information. See
Accessing the Simplex 4100 Card Editor on Page 61.

l You can right-click a card in the Hardware Tree and click View Points to see a list of all the Points configured for this card.
See Viewing Simplex 4100 Points for a Card on Page 60.

l You can right-click a card in the Hardware Tree and click New Point to manually create a new Simplex 4100 Point object
for this card. See Creating New Simplex 4100 Points for a Card on Page 60.

Viewing Simplex 4100 Points for a Card

From the Hardware Tree, you can view a list of the Points and Pseudo Points associated with a Simplex 4100 Card.

To View Simplex 4100 Points for a Card

1. From the C•CURE 9000 Administration application, choose theHardware pane.

2. Navigate to the folder containing your Simplex 4100 Panel.

3. Open the Simplex 4100 folder by clicking to the left of folder.

4. Click to the left of Panel icon ( ) to display the Cards connected to the panel.

5. Right-click on a Card to display the context menu.

6. Select View Points from the context menu. The list of points for that Card is displayed in the Content pane as a Dynamic
View.

Creating New Simplex 4100 Points for a Card

From the Hardware Tree, you can create a new physical Points associated with a Simplex 4100 Card.

To Create a Simplex 4100 Point for a Card

1. From the C•CURE 9000 Administration application, choose theHardware pane.

2. Navigate to the folder containing your Simplex 4100 Panel.

3. Open the Simplex 4100 folder by clicking to the left of folder.
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4. Click to the left of Panel icon ( ) to display the Cards connected to the panel.

5. Right-click on a Card to display the context menu.

6. Select New Point from the context menu. The Simplex 4100 Point Editor opens (see Figure 5-60 on Page 65), and you can
configure a new physical Point for that Simplex 4100 Card.

Simplex 4100 Card Editor General Tab

Once you have synchronized data from your Simplex 4100 hardware, some cards appear under the Simplex 4100 Panel tree
node.

Accessing the Simplex 4100 Card Editor

To Access the Simplex 4100 Card Editor

1. From the C•CURE 9000 Administration application, choose theHardware pane.

2. Navigate to the folder containing your Simplex 4100 Panel.

If the Simplex 4100 Panel object has synchronized data from the Simplex 4100 hardware, some Simplex 4100 Cards
appear underSimplex 4100 Panel>Simplex 4100 Card, as shown in Figure 4-57 on Page 61.

Figure 4-57: Simplex Card in the Hardware Tree

3. Double-click a card object. The Simplex Card Editor appears, as shown in Figure 4-58 on Page 62



Figure 4-58: Simplex Card Editor

4. You can view theCard Name andCard Number in this dialog box, as well as enter comments in theDescription field.
All other fields are read-only.

Simplex Card Editor Definitions

Table 10 on Page 62 describes the fields on the Simplex Card Editor General Tab.
Table 10: Simplex Card Editor General Tab Definitions

Field Description

Name The name of the Card.

Description Enter a description of the Card to identify it in your configuration.

Card Name The name of the Card.

Card Number The Card Number of the Card in the Simplex 4100 Panel.
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Chapter 5 - Simplex 4100 Point Editor

This chapter explains how to create and configure Simplex 4100 Points.

In this chapter

Simplex 4100 Point Editor Overview 64
Simplex 4100 Point Editor General Tab 64
Simplex 4100 Point Editor Status Tab 66
Simplex 4100 Point Editor Triggers Tab 67
Defining Triggers for a Simplex 4100 Point 68
Simplex 4100 Point Editor State Images Tab 70
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Simplex 4100 Point Editor Overview

The Simplex 4100 Point Editor is used to view and configure points that are connected to your panel.

Simplex 4100 Point Editor Tabs

The Point Editor has the following tabs:

l Simplex 4100 Point Editor General Tab on Page 64

l Simplex 4100 Point Editor Status Tab on Page 66

l Simplex 4100 Point Editor Triggers Tab on Page 67

l Simplex 4100 Point Editor State Images Tab on Page 70

Simplex 4100 Point Editor Tasks

The Simplex 4100 Point Editor lets you configure a Simplex 4100 Point by performing the following tasks:

l Defining Triggers for a Simplex 4100 Point on Page 68

l Customizing State Images for a Simplex 4100 Point on Page 71

Simplex 4100 Point Editor General Tab

Once you have synchronized data from the Simplex 4100 Hardware to your C•CURE 9000 database, you can configure a
Simplex 4100 Point.

l Right-click on a Simplex 4100Physical Card in the Hardware Tree and click New Point on the context menu to open the
Simplex 4100 Point Editor and create a new Simplex 4100 Point.

Figure 5-59: Hardware Pane

– or –

l Double-click an existing Simplex 4100 Point Instance to open the Simplex 4100 Point Editor (Figure 5-60 on Page 65
shows the Simplex 4100 Point General tab).
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Figure 5-60: Simplex 4100 Point Editor General Tab

Simplex 4100 Point Editor General Tab Definitions

The Point Editor General tab field definitions are provided in Table 11 on Page 65.
Table 11: Simplex 4100 Point Editor General Tab Definitions

Field Description

Name Enter a unique name up to 50 characters long for the Simplex 4100 Point. If you enter the name of an
existing object, the system returns an error message indicating there is a conflict.

Description Enter a general comment about the simplex 4100 Point. This text is for information only.

Enabled Click Enabled to allow the Simplex 4100 point to accept fire alarm information.

PID This read-only field identifies the point. Its format is Card Number-Point Number-Sub point Number

Card
Number

This read-only field indicates the card number associated with the current point.

Panel This read-only field designates the panel job number, indicating the panel to which the current point is
connected.

Device
Type

Select the point device type.

Point Type Select the point type.

Point Type
Banner

Enter the point type banner.



Simplex 4100 Point Editor Status Tab

The Simplex 4100 Point Status tab provides read-only status information about the Simplex 4100 Point object, as shown in
Figure 5-61 on Page 66

Figure 5-61: Simplex 4100 Point Editor Status Tab

Simplex 4100 Point Editor Status Tab Definitions

Table 12 on Page 66 provides definitions of the fields on the Simplex 4100 Point Editor Status tab.
Table 12: Simplex 4100 Point Editor Status Tab Definitions

Field Description

Fire Alarm
Status

Three possible values: Normal, Abnormal, and Abnormal with ACK.

Priority 2
Status

Three possible values: Normal, Abnormal, and Abnormal with ACK.

Supervisory
Status

Seven possible values: Normal, AbnormalNeedAcknowledgement, AbnormalAcknowledged, invalid,
Unknown, offline, disabled.

Trouble Status Three possible values: Normal, Abnormal, and Abnormal with ACK.
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Simplex 4100 Point Editor Triggers Tab

C•CURE 9000 uses Triggers, which are configured procedures for activating events based on properties of an object. A Trigger
automatically executes a specified Action when a particular predefined condition occurs. Figure 5-62 on Page 67 shows the
Simplex 4100 Point Triggers tab.

Figure 5-62: Simplex 4100 Point Triggers Tab

Table 13 on Page 67 shows an example of how a Trigger is configured.  
Table 13: Triggers Tab Settings Example

The following Triggers tab settings:

Property Value Action Details Schedule

FireAlarmState AbnormalAcknowledged Activate Event Simplex Point
Event

Always

Would create the following Trigger:
Any time (Always Schedule) the FireAlarmState (Property) equals AbnormalAcknowledged (Value),
activate the event (Action) named Simplex Point Event (Details).
Simplex Panel Event is an Event that you would need to create using the Event Editor.

Simplex 4100 Point Triggers Tab Definitions

Table 14 on Page 68 provides definitions for the fields and buttons that appear on the Simplex 4100 Point Triggers tab.



Table 14: Simplex 4100 Point Editor Triggers Definitions

Property Values Actions Comments

FireAlarmState None,
Normal,
AbnormalNeedAcknowledgement,
or
AbnormalAcknowledged

Activate
Event

Physical Point (sensor) status, you can set a
notification event to notify an operator when one
point's fire status has changed.

Priority2State None,
Normal,
AbnormalNeedAcknowledgement,
or
AbnormalAcknowledged

Activate
Event

Physical Point (sensor) status, you can set a
notification event to notify an operator when one
point's Priority status has changed.

SupervisoryState None,
Normal,
AbnormalNeedAcknowledgement,
or
AbnormalAcknowledged

Activate
Event

Physical Point (sensor) status, you can set a
notification event to notify an operator when one
points Supervisory status has changed.

TroubleState None,
Normal,
AbnormalNeedAcknowledgement,
or
AbnormalAcknowledged

Activate
Event

Physical Point (sensor) status, you can set a
notification event to notify an operator when one
point's Trouble status has changed.

Simplex 4100 Point Triggers Tab Tasks

SeeDefining Triggers for a Simplex 4100 Point on Page 68 for steps to define Triggers for your Simplex 4100 Point.

Defining Triggers for a Simplex 4100 Point

Perform the following steps to create a Trigger for a Simplex 4100 Point.

To Configure a Triggers for a Simplex 4100 Point

1. From the Simplex 4100 Point dialog box, navigate to the Triggers tab.

2. Click in the Triggers tab to create a new Trigger.

3. Click within the Property column to open the Simplex Point dialog box showing the Properties available for the
Simplex Point.

4. Click a Property to select it and add it to theProperty column.

5. Click within theValue column to enter a value that you want to include as a parameter for the trigger to add it to the
column. (If there is a set list of Values, you can select a Value.)

6. Click within theAction column to display a drop-down list of valid actions. Click an Action that you want to include as a
parameter for the trigger to add it to the column.

When you select an Action, the lower pane in the Triggers box displays an entry field or group of entry fields, specific to the
selected Action, so that you can configure the Details for the Action.
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Once you define the Action details, the Details column displays information about how the Action has been configured.

For example, if an Event field is displayed in Details, you can click to select an Event that you want to associate with
the Trigger.

7. Click to save the Simplex 4100 Point with the Trigger you configured.



To Remove a Trigger

1. From the Simplex Point dialog box, navigate to the Triggers tab.

2. Use to select the row in the Triggers table for the Trigger you want to remove.

3. Click .

4. Click to save the Simplex 4100 Point .

Simplex 4100 Point Editor State Images Tab

The State Images tab, shown in Figure 5-63 on Page 70, allows you to change the default images used to indicate the Simplex
4100 Point states on theMonitoring Station.

Figure 5-63: Simplex 4100 Point Editor State Images Tab

You can replace the default images with JPG formatted files of your choice, to uniquely identify your objects when activities
are displayed on theMonitoring Station Client. Simplex 4100 integration also provides pre-defined custom icons for 4100 points

under CCURE Client\SimplexIcon folder. The following picture shows all pre-defined point icons.
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Customizing State Images for a Simplex 4100 Point

You can customize the state images for a Simplex 4100 Point using your own .JPG format images.

To Customize Simplex 4100 Comm Port State Images

1. From the Simplex Point State Images tab, double-click the existing image for the State you wish to change.

A Windows Open dialog box appears allowing you to browse for a folder in which you have placed replacement images.

2. When you locate the replacement image, select it and click Open to replace the default image with this image.

3. When you are done editing the Simplex Point, click to save the Simplex 4100 Point's configuration.

To Restore a Point Default State Image

1. From the Simplex 4100 Point Editor State Images tab, select an existing image.

2. Right-click the image and select Restore Default.

3. Click to save the Simplex 4100 Point's configuration.
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Chapter 6 - Monitoring Simplex 4100 Activities

You canmonitor Simplex 4100 activities using theMonitoring Station Activity Monitor.

In this chapter

Using theMonitoring Station for Simplex 4100 Fire Alarms 73
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Using the Monitoring Station for Simplex 4100 Fire Alarms

Themain purpose of the Simplex Fire Alarm Interface is to notify Operators when there is an alarm. You can check the alarm
status for the Simplex 4100 Fire Alarm Interface on the C•CURE 9000Monitoring Station. When you install the Simplex 4100
Fire Alarm Interface, it automatically creates a Simplex Fire Alarm Application Layout. You can then assign this Layout to your
Operators, modifying the Layout for each specific Operator, as you wish.

To Configure a Simplex Fire Alarm Application Layout for an Operator

1. From the C•CURE 9000 Administration application, choose the Configuration pane, then chooseOperator from the drop-
down list box.

2. Click to view a Dynamic View of all operators (see Figure 6-64 on Page 73).

Figure 6-64: Dynamic View of Operators

3. Double-click the Operator you want to see Fire Alarm Information in theMonitoring Station. TheOperator editor opens (as
shown in Figure 6-65 on Page 74).
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Figure 6-65: Operator Editor

4. Navigate to the Layout tab and click Add to configure a layout for the Operator. A dialog box opens displaying the available
Application Layouts.

Figure 6-66: Application Layout Dialog Box

5. Select theSimplex 4100 Alarm Point DefaultApplication Layout and click OK. The Simplex 4100 Alarm Point default
Application Layout is added to the Operator on the Layout tab.

6. Click Save and Close to save the Operator configuration.



To View the Simplex Fire Alarm Application Layout

Once you have configured the Simplex 4100 Alarm Point default Application Layout, an Operator

can use theMonitoring Station to see alarm information.

1. To start theMonitoring Station, select one of the following options:

• Click START>All Programs>Software House>C•CURE 9000>Monitoring Station.

• Click the desktop icon, .

TheMonitoring Station opens, showing the Simplex layout.

Figure 6-67: Monitoring Station

When the Simplex 4100 hardware reports any abnormal status, such as fire, trouble, supervisory, priority 2 problem, the
Monitoring Station displays this information in the Activity Viewer, and all abnormal points are listed on the bottom in the
Simplex Panel abnormal point list.

This list does not refresh automatically; you should click to refresh the Simplex Panel abnormal point list.
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Chapter 7 - Simplex 4100 Journal Messages

The Simplex 4100 Fire Alarm Interface has customized Journal Messages that are described here.

In this chapter

Simplex 4100 Journal Message Definitions 77
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Simplex 4100 Journal Message Definitions

The Simplex 4100 Fire Alarm Interface provides six categories of journal information for the C•CURE 9000 database. These
Journal Messages are summarized in Table 15 on Page 77, on Page 77, Table 16 on Page 77, and Table 17 on Page 78.

"#" in the table is used to represent an object such as a panel name, point name, or computer name. The actual value for the
object property will replace the "#" in the Journal.

Table 15: Simplex 4100 Fire Changed State Journal Messages

Category Object State Change Messages

Fire Changed State Panel Online Simplex4100 Panel # is online.

Offline Simplex Panel # is offline.

Table 16: Simplex 4100 Fire Activity Journal Messages

Category Object State Change Messages

Fire Activity
XPoint unsolicitedmessage
has change time as Message
Data/Time; and the point
could exist or not exist

XPoint
unsolicited
message

State is abnormal Simplex4100 Point # on Simplex4100 Panel #
is in fire alarm needs acknowledgment state.
Simplex4100 Point # on Simplex4100 Panel #
is in priority 2 alarm needs acknowledgment
state.
Simplex4100 Point # on Simplex4100 Panel #
is in supervisory with acknowledged state.
Simplex4100 Point # on Simplex4100 Panel #
is in trouble with acknowledged state

State is normal The fire alarm state of Simplex4100 Point # on
Simplex4100 Panel # is normal.
The trouble state of Simplex4100 Point # on
Simplex4100 Panel # is normal.

XHStart
FormatString:
# on Panel #

Cold start on Panel #.
Warm start on Panel #.

Data
acquisition
(automatic)

Data acquisition on Panel # started.
Data acquisition on Panel # completed.
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Table 17: Simplex 4100 Fire Device Activity Journal Messages

Category Format Messages

Fire Device Activity
A blank job revision does not mean the panel
is invalid.

XHStart
FormatString:
# on Panel #

Cold start on Simplex4100 Panel #.
Warm start on Simplex4100 Panel #.

Invalid Panel error Mismatch JobNumber on Simplex4100 Panel #.
Terminal information does not match on
Simplex4100 Panel #.
Unsupported system revision on Simplex4100
Panel #.
Unexpected job revision on Simplex4100 Panel #.
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